SKF Static Motor Analyzer

Baker AWA-IV

Part number: 71-050 EN V3
SKF Static Motor Analyzer

Baker AWA-IV

Quick Reference Guide

Part number: 71-050 EN

Revision: V3

Copyright © 2017 by SKF USA, Inc.
All rights reserved.

SKF USA, Inc.

4812 McMurry Ave. Suite 100
Fort Collins, CO 80525
(970) 282-1200
(970) 282-1010 (FAX)
800-752-8272 (USA Only)
http://www.skf.com/emcm

NOTICE

SKF USA, Inc. assumes no liability for damages consequent to the use of this product.

Information furnished in this manual by SKF USA, Inc. is believed to be accurate and reliable. However, SKF USA, Inc. assumes no responsibility for the use of such information or for any infringements of patents or other rights of third parties that may result from its use. No license is granted by implication or otherwise under any patent rights of SKF USA, Inc.

SKF USA, Inc. assumes no liability for damages consequent to the use of this product. No part of this document may be reproduced in part or in full by any means such as photocopying, photographs, electronic recording, videotaping, facsimile, etc. without written permission from SKF USA, Inc. Fort Collins, Colorado.
CAUTION

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC rules. These limits are designed to provide reasonable protection against harmful interference with the equipment is operated in its installation.

This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the product manual, could cause harmful interference to radio communications. If this equipment does cause harmful interference, the user will be required to correct the interference. Due to the phenomena being observed and the material properties being measured, this equipment radiates radio frequency energy while in the active test mode. Care should be taken to ensure this radio frequency energy causes no harm to individuals or other nearby equipment.

Safety precautions

WARNING

Never exceed maximum operating capabilities of the Baker AWA-IV tester, power packs, or the Baker ZTX accessory. If using the equipment in any manner not specified by SKF USA, Inc. the protection provided by the equipment may be impaired.

Be sure to comply with all safety procedures prescribed by your organization, industry, and governing standards. Failure to heed safety precautions can result in injury or death from severe electrical shock.

Additional information reference

The Baker AWA-IV Quick Reference Guide is intended to introduce users to the analyzer and its basic operating procedures. For complete safety information and detailed information on the device, end-user license agreement, and CE conformity refer to the Baker AWA-IV User Manual.
# Table of contents

Safety precautions ................................................................................................................. ii
Additional information reference ......................................................................................... ii

1 Baker AWA-IV instrument overview  
   Baker AWA-IV 2 kV/4 kV model front panel ................................................................. 1  
   Baker AWA-IV 6 kV/12 kV model front panel ............................................................... 3

2 Preparing for testing  
   Process overview .......................................................................................................... 4  
   Creating or opening a database ..................................................................................... 4  
   Selecting a motor to test ............................................................................................... 5  
   Creating a new Motor ID .............................................................................................. 5  
   Creating a new Test ID ................................................................................................. 7  
   Selecting tests and setting up test parameters ............................................................ 9

3 Basic testing procedures  
   Using the Explore, Motor ID, and Route tabs to find motors ..................................... 16  
   Running tests automatically, semi-automatically, or manually ................................ 17  
   Test sequence ............................................................................................................... 19  
   Reviewing test results/data ......................................................................................... 21  
   Printing reports .......................................................................................................... 23
1 Baker AWA-IV instrument overview

Baker AWA-IV 2 kV/4 kV model front panel

All Baker AWA-IV series analyzers feature an eight-inch touch screen with a graphical user interface. The interface features a logical layout of touch icons that improve ease of use. Each tester’s voltage capacity is identified by the markings found just below the touch screen.

![Front panel controls for AWA-IV 2 kV and 4 kV models.](image)

*Figure 1.* Front panel controls for AWA-IV 2 kV and 4 kV models.

**VGA port**

The VGA port is used to connect the tester to a larger monitor (not included) for easier viewing of test results.

**USB ports**

Industry standard USB ports are accessible from the front panel for connections to a printing device, and data storage and retrieval devices.
Ethernet connector
The tester can be connected to a network via the ethernet connector.

Emergency power shut-off
This large, highly visible red button is easily pressed on the front panel for emergency shut-downs. It cuts all power to the unit swiftly and safely.

Low-voltage resistance test leads
Three test leads (red) and a ground lead (black) are provided for motor test connections. Both sides of the connection clips must be in contact with the terminal of the motor being measured. Most recent AWA-IV 2/4kV testers have two low-voltage resistance test leads. Ensure that the leads are connected as shown in the example below.

Correct orientation   Incorrect orientation

*Figure 2.* Proper orientation of AWA-IV 2/4 kV 2-lead connectors.

AWA-IV6 analyzers use the high-voltage leads for low-voltage resistance testing (no additional set of leads).

AWA-IV 12kV analyzers have three red test leads for low-voltage resistance testing (no black lead).

High-voltage test leads
The Baker AWA-IV uses high-voltage test leads for surge, Baker ZTX, and DC testing. You must keep the leads clean and dry for best measurement performance. The AWA-IV 6 KV model differs from the AWA-IV 12 kV with respect to test leads and procedures for use.

The AWA-IV 6 kV analyzer uses only one set of leads for both high- and low-voltage testing; it does not include a separate set of low-voltage test leads (shown as “low-voltage resistance test leads” in the image).

Voltage output control knob
Turn the knob clockwise to increase the applied voltage or counterclockwise to decrease the voltage. The rate of voltage increase or decrease is set via the touch screen interface. Do not force the knob; turning the knob harder does not cause voltage to ramp any quicker and may damage the instrument.
Baker AWA-IV instrument overview

Baker AWA-IV 6 kV/12 kV model front panel

Figure 3. Front panel controls for Baker AWA-IV 6 kV and 12 kV models.

CAUTION

It is important to note that test lead clips have exposed metal areas. Do not touch the clips while tests are running. Always exercise care to ensure the clips are not placed in proximity to the frame or ground potential.
2 Preparing for testing

Process overview

The basic process for testing a motor on the AWA-IV includes the following steps:
1) Open an existing database or create a new one.
2) Select an existing motor to test, or create a new motor (motor ID and test ID).
3) Select tests to run.
4) View and confirm test parameters, or modify test parameters.
5) Run tests automatically, semi-automatically, or manually.

Each step is described in more detail in this chapter.

Creating or opening a database

1) Start the Baker AWA-IV application by clicking on the icon on the tester screen or the MS Windows Start button.
2) Click on the appropriate radio button for creating a new database or opening an existing one.

![Figure 4. Dialog box for creating or opening a database.]

3) When creating a new database, a dialog box will open so you can name the new database. Enter the database name in the field then click OK.
4) When opening an existing database, highlight the database needed from the list and click OK.
Selecting a motor to test

1) Click on the Data tab to select existing motors, or to create and store information for new motors. Each motor will be listed in the Explore tab's Motor Tree on the left side of the screen. The Motor Tree provides a complete listing of all motors stored in a particular database.

2) To select the Motor ID for an existing motor, locate it within the Explore tab then click on the Motor ID to highlight it and to load its information in the Data tab.

Creating a new Motor ID

1) If the motor you are testing does not yet have a Motor ID in the system, you will need to create a new Motor ID. To add a new Motor ID to the selected database, click on the Add button.

2) Click on the Clear button to remove all information currently entered in the fields.

3) Type the Motor ID, Location, Building, and nameplate information in the appropriate fields.

4) Best practices suggest adding all information pertinent to the motor to facilitate testing. This information can be useful during the testing and troubleshooting processes.

5) Click on the Save button to add the motor information to the database.

NOTE
The labels for the Location and Building fields can be changed as desired by using the Options --> Changeable Labels items in the View tab.
6) The **Select Test ID** dialog box will appear so you can assign the most appropriate Test ID to the motor. Test IDs contain the testing parameters (for example, tests performed, voltages, and pass/fail criteria) along with a basic motor description. For example, a Test ID named 480Vw/Rotor>100HP StepV includes tests for a 480-volt motor that has the rotor installed during testing, is less than 100 horsepower and will feature step voltage testing.

7) Click **OK** after selecting the best available Test ID for the motor you will be testing.

---

**Figure 6.** New motor added to Motor Tree. Information entry and Test ID selection.

8) The new motor will appear in the motor tree on the left side of screen.

9) You can then view the tests selected for the motor along with the test parameters then make adjustments if needed to better suit your testing objectives.
Creating a new Test ID

If a Test ID does not exist for the motor you want to test, you can create a new one for current and future use.

1) Click on the Tests tab.
2) Click on the Edit Test ID checkbox to enter edit mode.
3) Test IDs can be password protected if desired. If a password has not been set up and you want to use one, enter a new one in the Password field. To change a password, click on Change Password, type in the current password (if applicable), enter the new password and confirm then click on Set Password.
4) Click OK to close the password dialog box.

5) Click the Add button. The Create New Test ID dialog box appears.
6) If an existing Test ID is close to what you will need, ensure that it is selected in the Test ID field then click on the Copy Current Test ID radio button. Otherwise, click on the Add Blank Test ID radio button to start from scratch.
7) Give the new Test ID a descriptive name and choose a target motor voltage class from the drop-down list then click on OK.
8) You can further modify the Test ID by selecting the desired tests to be performed via the On/Off buttons.

9) You can also provide specific values and parameters for each test as needed by clicking on the Configure/View buttons. In the following example, DA Only is selected from the DA/PI tests drop-down list and Ramp Voltage is selected from the HiPot/Step Voltage test list.

10) Click Save to save the changes made to the new Test ID or click OK in response to a confirmation dialog appearing after making parameter changes. The new Test ID will be added to the list.
Selecting tests and setting up test parameters

As noted in the process for creating a new Test ID, you can select which tests you want to run for a selected motor by clicking on the ON/OFF buttons for each test type. You can also view and configure parameters for each test type by clicking on the buttons in the right column for each test type.

Figure 11. Selecting tests to perform, and controls for configuring/view test parameters.

NOTE
The following sections provide brief introductions to each test setup screen. For details on the screens and the parameters set within, refer to the AWA-IV user manual.
**Setting up temperature and resistance tests**

1) To enter the temperature value and set up resistance tests, click on either the **Manual** or **3 Lead/High V** button.

2) The **Temperature/Resistance Test** screen appears so you can provide the information needed for your test.

3) Using this screen, you can enable or disable temperature entry or resistance testing, select specific parameters to include in your testing, or adjust testing parameters to fit your needs.

4) The **Test Results** section shown at the bottom of the screen provides a view of the results collected when the test runs automatically or semi-automatically. You can also use this section directly during manual testing.

5) When you have completed your setup, close the screen.

---

![Temperature/Resistance Test setup screen.](image)

---

**Figure 12.** Temperature/Resistance Test setup screen.
**Setting up DC tests**

1) Enter into the DC Tests setup screen by clicking on any of the voltage buttons next to the DC tests listed.

2) Using this screen, you can enable or disable test types, select DC test types to include in your testing, select specific parameters to include in your testing, or adjust testing parameters to fit your needs.

3) You can use the default values provided, or you can modify parameters based on IEEE, EPRI, EASA, IEC, or company standards.

4) Depending on the test types selected, other controls may appear within the screen.

5) If you want to use temperature correction for your DC tests, check the Temp Correction Enable box (even if you have checked this option in the resistance test setup screen.)

6) The “Run Tests” buttons near the bottom left of the screen are used to control testing during manual testing. The Voltage and Current displays to the right show you value being measured during testing.

7) When you have completed your setup, close the screen.

---

**Figure 13.** DC Tests setup screen.
Setting up a Step-Voltage test

1) From the DC TESTS screen, click on the drop-down list for HiPot/Step Voltage then click on Step Voltage as shown in the image below. This will open the Config Wizard.

![Figure 14. Setting up Step-Voltage test parameters.](image)

2) Set each value to a desired level and click Next.

![Figure 15. Step-Voltage Configuration Wizard; setting voltage parameters.](image)

3) Add or delete steps within this screen as needed, then click Finish to save the setup.
4) When you have completed your setup, close the screen.

Figure 16. Step-Voltage Configuration Wizard; adding steps.
**Setting up a Surge test**

1) Click on the voltage button in the **Surge Test** section to enter the setup screen.

2) Using this screen, you can select options to use during testing, select parameters to include in testing, and specify test parameter values.

3) Enter parameters based on IEEE, EPRI, EASA, IEC, or company standards.

4) Set Pass/Fail tolerances as needed for the motor under test.

5) You can also check the **ZS Override** button if you want the tester to automatically start at the **Surge Voltage** level, removing the need to ramp up and allowing the tester to reach the target voltage faster. This feature is available only for semi-automatic or manual testing. Additionally, the feature cannot be saved as part of a Test ID.

**WARNING**

When using ZS Override, test voltage will not start at zero. Because the tester will immediately apply higher test voltages to the motor, take all precautions to avoid injury or death from severe electrical shock.

6) The large graph area plots the surge waveform during testing.

7) The **Run Surge** controls are used during manual testing.

8) When you are satisfied with your specifications, close the **Surge Test** setup screen.
Preparing for testing

When you have completed the processes for selecting an existing motor ID, creating a new motor ID (and Test ID), selecting tests to run, and confirming or modifying test parameters, you will be ready to run the tests on your motor. Details for running tests automatically, semi-automatically, or manually are provided in the next section along with other operating procedure information.

**Surge testing through capacitors**

The surge test is load dependent. Anything that adds capacitance to the motor or system under test will create more load on the tester.

When surge testing a motor, all capacitors should be removed or the ground should be lifted. Otherwise, the capacitors will absorb the surge pulse, preventing it from entering the coils.

**Rotor effect on testing**

When possible, remove or secure the rotor before testing. Rotors can affect testing results, particularly if they move (even slightly) during testing. Some issues can be erroneous high resistance imbalance in coil testing due to increased inductance, inability to polarize for DA/PI testing, or frequency shift in one or more waveform values during surge testing. An erratic PP EAR will often result and the shift could even trip the EAR limits.
3  Basic testing procedures

Using the Explore, Motor ID, and Route tabs to find motors

The left side of the screen is used to navigate through the motors within the opened database. Three methods can be used:

**The Explore tab**

The *Explore* tab includes a tree structure to help you select a particular Motor ID. The two upper levels of the tree correspond to the location and building in which the physical motor is housed. *Location* and *Building* are the default tree labels, but they can be changed. The lowest level is the Motor ID.

**The Motor ID tab**

The *Motor ID* list box provides an alphabetical listing of all motors found in the database. In the edit box located above the list, the currently selected Motor ID is displayed. Locate a Motor ID using one of two ways within this tab:

- Begin typing the desired Motor ID in the edit box. The list will automatically scroll to the nearest Motor ID that begins with those characters.
- Otherwise, scroll down the list until the Motor ID is located. Double click on the Motor ID or highlight the Motor ID and click the *Display* button to select.

**The Route tab**

The *Route* tab allows construction of individual lists of Motor IDs for routing purposes. As seen in the example, the “Spring Outage” list is selected. This list has four associated motors.

You do not need to search the entire database to find the motors to be tested during the “spring outage” event. This tab also allows you to edit and print the routes.

To select a motor, simply click on the motor name in the route list.

Click on the *Edit Route* button to start the editor.

The *Route Editor* dialog box appears to help you add, rename, and delete routes. It also provides tools to add, remove, and change the order of the Motor IDs within a list.

![Figure 18](image-url)  Use the *Route Editor* to manage route information.
Running tests automatically, semi-automatically, or manually

After you have selected a motor for testing, completed selecting the tests you want to run, and made adjustments to the test parameters (if needed) you can simply click on the red **Run Auto Test** button found in the **Tests** tab. The software will then execute each test in turn, providing you with visual cues along the way for setting up test leads, entering temperature values (if selected), and displaying test results within the related test screens.

![Figure 19](image1.png)

*Figure 19.* Controls used to run automatic and semi-automatic testing.

You can run tests semi-automatically by clicking on the individual test type buttons found in the **Tests** tab. The software will perform the same functions as during automatic testing, but only for the selected test.

As noted in the setup screen descriptions, each screen has controls for manually executing tests. Resistance and surge tests even allow you to test individual leads. Tests can also be run manually using the analyzer’s front panel controls.

![Figure 20](image2.png)

*Figure 20.* Controls within setup screens to run tests manually.
An automatic test will analyze the motor in the following sequence:
1) Resistance
2) Megohm
3) PI/DA
4) DC HiPot/DC Step Voltage
5) Surge

**NOTE**
The actual tests performed will depend on the tests you select for your motor.

At the end of the sequence, the test data will automatically be saved to the database.
1) To start an automatic test, ensure that the motor is selected.
2) Click on the **Tests** tab to get to the main testing screen.
3) To start the test, click on the red **Run Auto Test** button and follow the directions.
4) The **Safe To Turn On** dialog box appears when a high-voltage test is selected. Typically, it instructs you to verify that the correct set of leads have been properly connected; however, the content of the message can vary depending on your tester configuration.

![Safe to Turn On dialog box](image)

*Figure 21.* Safe to Turn On dialog box; message content can vary.

5) Follow the instructions in the dialog to continue the testing process. When all tests have been run, the test data will automatically be saved to the database and the main test screen will re-appear.

**NOTE**
Not all Baker AWA-IV testers have low-voltage test leads. If this option is not available, this screen will be slightly different; however, the test operation is the same.
Test sequence

The following sequence of tests will run automatically. If a test fails, the software will stop the testing process, leads will be discharged and grounded, and you will be presented with choices for continuing testing if applicable.

Under most circumstances, you should troubleshoot, diagnose, and repair the motor before going on to the next test in the sequence.

Temperature entry

The Temperature/Resistance dialog will be displayed ready for the temperature reading to be entered from a third party temperature device.

1) Enter the temperature off the motor and click the Accept button to acknowledge the temperature being entered.

2) Click Next to proceed. The tester will automatically proceed with the remainder of the tests.

Resistance

This test looks for resistance imbalance between phases. If a large imbalance is found, inspect the motor for causes of the discrepancy. By comparing the values to a reference standard, you can evaluate the following quality and degradation issues:

Field testing—Inspect connections in junction box and look for high resistance connections, and improper or loose connections.

Quality/post failure—Look for number of turn per phase variation, diameter copper variation, turn-to-turn shorts, or turn opens.

Megohm

A Megohm test uses a test voltage close to the motor’s operating voltage and appropriate standards and/or company guidelines. This voltage will be held for 60 seconds during which the analyzer watches for overcurrent conditions and micro-arcs or insulation resistance values below the minimum megohm setting. Look for an unusually low Megohm value when compared to previous measurements or industry accepted limits. If a low Megohm value is measured, inspect the motor for ground wall insulation damage.

PI/DA

The Polarization Index (PI) test measures the insulation’s ability to polarize. When an insulator polarizes, the electric dipoles distributed throughout the insulator align with the applied electric field. As the molecules polarize, a polarization (absorption) current develops and adds to the insulation’s leakage current. The additional polarization current decreases over time and drops to zero when the insulation is completely polarized.

The PI test is typically performed at 500, 1000, 2500, or 5000 volts depending on the motor’s operating voltage. The duration of the PI test is 10 minutes (600 seconds). The PI value is calculated by dividing the insulation resistance at 1 minute by the resistance at 10 minutes. In general, damaged insulators will show a low polarization index.

Many insulating materials do not easily polarize. If the 1-minute insulation resistance is greater than 5000 Megohms, the PI measurement may not be meaningful.

The PI test is performed on motor 100 Hp or greater. Motors less than 100 Hp should use the Dielectric Absorption (DA) test. On the AWA, set the PI minimum alarm at 2.0 for class B, F, and H insulation, and 1.5 for class A insulation.
The PI test should not be used as the basis for any motor acceptance criteria. It should be used as a trending and diagnosis tool along with other test results, including the PI curve generated.

If the Test ID was set up for a DA test, the test duration will be three minutes (180 seconds).

**DC HiPot/Step Voltage**

The HiPot test is performed at a test voltage higher than the Megohm test; that is, at voltages typically encountered at start-up. Actual test voltages are based on the motor’s operating voltage and appropriate standards and/or company guidelines.

Look for unusually high leakage currents or a leakage current that does not stay constant. High leakage currents indicate weak ground wall insulation.

During a Step Voltage test, voltage is applied to all three phases of the winding and raised slowly to programmed levels then held for a predetermined period. This process is executed in equal increments (steps) until the target maximum voltage level is reached. Because the test is most stable at the end of each step, data is logged at this point. If the leakage current doubles from a given step to the next, an insulation weakness is indicated and testing should be stopped. If leakage current increases consistently less than double, the motor insulation is likely good.

**Surge**

Effectively an electrical resonance test, the Surge test creates a nonlinear voltage drop across the windings, stressing the turn-to-turn insulation. If weak insulation exists, the differential voltage will short out a bit of the winding, causing the overall inductance to go down.

Surge testing measures pulse-to-pulse EAR (Error Area Ratio) by default, and can also measure line-to-line EAR. (Refer to the AWA-IV User Manual for details on Surge testing and EAR measurement.)

During testing, the voltage will be slowly increased on lead 1 to the voltage specified in the Test ID. If no pulse-to-pulse EAR failures are detected, leads 2 and 3 will be tested.

A shift to the left in the waveform patterns is a common indicator of weak insulation.

<table>
<thead>
<tr>
<th>Failure modes</th>
<th>Winding Resistance</th>
<th>Meg test</th>
<th>PI test</th>
<th>Step Voltage</th>
<th>Surge</th>
</tr>
</thead>
<tbody>
<tr>
<td>Weak insulation (turn-turn)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Weak insulation (phase-phase)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Weak insulation (coil-coil)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Turn-turn shorts</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Phase-phase shorts</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Coil-coil shorts</td>
<td>X</td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Open coils</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Reversed coils</td>
<td>X</td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Unbalanced phases</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Weak ground wall insulation</td>
<td>X</td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Dirty windings</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Moisture</td>
<td>X</td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Faulty feeder cables</td>
<td>X</td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Motor lead line connections</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
</tbody>
</table>

*Figure 22. Fault analysis chart.*
Reviewing test results/data

After the test results have been saved to the database, they can be reviewed using the **Data** tab on the right pane of the analyzer software main window.

The **Results Summary** tab (accessed from the bottom of the pane) presents a Date/Time section at the top of the screen and a spreadsheet style view occupying the main display area.

![Figure 23. Data tab showing example results; Date/Time window.](image)

The Date/Time section shows a summary of the time and date of tests, and whether the tests passed or failed. Clicking on a specific test date/time loads the test records for that event into the main display area.

The spreadsheet style of the results view shows the actual test data acquired. The test date and time are shown in the first two rows. A header row marks the start of a results section for each test category followed by the specific test measurement results.

Color coding helps you see whether a test category includes all passing tests (green) or failing results for specific measurements (red).

![Figure 24. Example test results summary view.](image)
Basic testing procedures

The Surge, PI, and Step/Ramp Voltage test results can be viewed using the dedicated tabs found at the bottom of the pane.

For example, review the PI test by clicking on the PI tab. The PI view will display the PI/DA graph along with a table of the current and megohm readings gathered at specific times. The PI voltage, DA ratio, and PI ratio are displayed on the right side.

![PI test results](image)

*Figure 25.* Example PI test results.

The Surge test data can be reviewed by pressing the Surge tab.

![Surge test results](image)

*Figure 26.* Example Surge test results.
Printing reports

Complete report generation features are available to document test results for managers, customers, owners, repair personnel, and more. Reports contain test, nameplate, and application data and can be sent to a printer or output as an RTF file.

You have three options for starting the Report Generator:

- Click on the File menu then the Print menu item.
- Hold down the control key and press “P” on your keyboard.
- Click on the printer icon in the upper left of the main screen.

The Select Filters section of the Report Generator dialog contains a selection of print filters. Check the Current Motor/Test Results box, or use any combination of the filters such as a date range and all motors that fail any test during a given test range.

The Select Reports section provides a list of available reports and report options.

The simplest report to generate is the current test results, which appear to the right of the Current Motor/Test Results check box. Check the box then select which report(s) you want to generate.

NOTE

For more detailed information on printing reports along with additional information on testing, results analysis, recommended test voltages, applicable standards, data transfer, and more refer to the Baker AWA-IV User Manual.
The Power of Knowledge Engineering

Drawing on five areas of competence and application-specific expertise amassed over more than 100 years, SKF brings innovative solutions to OEMs and production facilities in every major industry worldwide. These five competence areas include bearings and units, seals, lubrication systems, mechatronics (combining mechanics and electronics into intelligent systems), and a wide range of services, from 3-D computer modelling to advanced condition monitoring and reliability and asset management systems. A global presence provides SKF customers uniform quality standards and worldwide product availability.